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この資料は定理証明支援系 Coq を利用して定理証明の初歩を分かりやすく解説する*1こ
とを目的としています．

∗ この講義資料は JSPS科研費 26560089の助成を受けた研究の過程で得られたものです．
*1 ただし，プログラミング言語としての特徴については扱わないので，Coqの全体像については参考文献「ソ
フトウェアの基礎」[1]を参照してほしい．
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1 Coq

1.1 Coqとは
Coqはフランスの INRIAで開発されている定理証明支援系である．Coqの公式ページに
は以下のように記載されている．

Coq is a formal proof management system. It provides a formal language to write

mathematical definitions, executable algorithms and theorems together with an

environment for semi-interactive development of machine-checked proofs. Typical

applications include the certification of properties of programming languages (e.g.

the CompCert compiler certification project, or the Bedrock verified low-level pro-

gramming library), the formalization of mathematics (e.g. the full formalization

of the Feit-Thompson theorem or homotopy type theory) and teaching.

1.2 Coqのインストール
Coq は https://github.com/coq/coq/releases よりダウンロードできる．Windows

OS や Mac OS X の場合はバイナリをダウンロードする．Linux 系の OS の場合は，パッ
ケージ管理ツールを利用してインストールする．Coq のライセンスは GNU LGPL ライセ
ンスである．

1.3 CoqIDEのウインドウ
Coq はコマンドラインでも実行可能であるが，ここでは CoqIDE を用いて説明する．

CoqIDEを起動すると 3ペインのウインドウが開く．

1



左側が編集で，右上は仮定とゴールの表示，右下は情報を表示する．

1.4 基本的な枠組み
Coqを使用する場合，基本的なライブラリーは読み込まれているが，必要に応じて外部ラ
イブラリーを読み込むことができる（2.1.9参照）．古典論理のライブラリーを読み込まない
限り，Coqで証明できるのは直観主義論理で証明できるもののみになる．Section宣言は使
わなくてもよいが，局所的な変数を使う場合は必要になる．Sectionを宣言する場合は，
Section 〈セクション名 〉.
のようにセクション名の後にピリオドをつける．Sectionの終わりは，
End 〈セクション名 〉.
とする．また，書いた内容を反映させるためには，式の評価を行なう必要がある．単純な式
の評価はメニューバーの下矢印をクリックする．あるいは Navigationメニュで Forwardを
選択してもよい．戻るにはメニューの上向き矢印（BackWard）を使う．他に全てを一度に
評価したり (End)，先頭に戻したり (Start)，指定された場所まで評価を行う (Go to）こと
ができる．キーボードショートカットを使うのが便利である．キーボードショートカットで
使用するModifierキーは，Edit->Preferences->Shortcutsで変更できる．

2 論理式の証明
2.1 命題論理

Coq では，すべての変数は型をもっている．例えば，Prop は命題の型を表していて，
A:Propのように表し，変数 Aが型 Propをもつことを表す．
論理式を証明するときは，証明する論理式の前に，Goal, Theorem, Lemmaなどを書く．
証明した論理式を後で参照する必要のない場合は Goalでよいが，あとでその事実を証明に
利用するのであれば，Theoremや Lemmaにする．Theoremと Lemmaに違いはなく，どちら
にするかは気持ちの問題である．証明する論理式には名前を付ける*2．そのセクションで共
通に使う変数は，Variableで宣言する．
Variable A B C:Prop.

命題 A,B に対し，A → (B → A)が成り立つことを証明する場合，
Lemma HA1:A->(B->A).

とする．論理結合子の → は Coq では，ハイフン-と大小記号>で表す．HA1 が論理式
A->(B->A) につけた名前*3である．これらを評価すると Coq は proof-editing モードに入
り，右上のペインに仮定とゴールが現れる．

*2 とりあえず定理証明する際に参照するための区別と考えればよいが，詳細は参考文献 [1], [2] を参照してほ
しい．

*3 この論理式は，ヒルベルトによる形式式的体系の公理の一つなので HA1と名前をつけている．
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証明を始める場合，Proof. を付けるが，付けなくてもよい．証明を終えたら（Coq が No

more subgoals.となったら）Qed.で終える．これで上記であれば，HA1として，A->(B->A)
が利用できる．

2.1.1 ゴールが含意の場合
実際に A->(B->A)を証明してみる．LJの推論規則*4の右→は，

A,Γ ` B

Γ ` A → B
(右→)

であるから，`A → (B → A)を示すには，A`B → Aを示せば良い．このように Aを仮
定に入れて，ゴールを B → Aに変更するには，introタクティック*5を用いる．intro.と
して評価するとそのように仮定とゴールが変換されることがわかる．

もう一度，introを行うと，A,B `Aとなり，ゴールと同じ仮定ができる．なお，評価した
タクティックの次は空白を入れる．入れないと先頭が赤字で表示され次の評価ができない．

ゴールと同じ仮定がある場合，LJ では始式から構造に関する推論規則で導かれるが，
Coq では trivial あるいは assumption を用いる．trivial. を評価すると No more

subgoals.となり証明が終了する．

*4 LJあるいは LKについては，参考文献 [3]を参照してほしい．Γを論理式の列とするとき，Γ⊢X の直観的
な意味は Γを仮定すると X が導くことができることである．

*5 タクティックについては [4]を参照してほしい。
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最後に Qed.で Lemma HA1が登録される．

上記では，intro を 2 回続けたが，これは intros で 1 回で行うことができる．ただし，
intros は単なる intro の繰り返しではない．2.1.6 で説明する．なお，intro を行うと
Coqが自動的に仮定に入る論理式に名前をつけるが，H, H0のように機械的な番号付になる
ので，自分で名前を付けたければ，intro K.のように指定できる．

仮定が多く出てくる場合は，このようにして名前を制御した方がよいが，このテキストでは
記載を簡単にするため一部を除いて特に指定はしないで証明を進める．
今挙げた例のように Coqでは，Γ`A → B を証明するには，A,Γ`B を証明すればよい
というように，LJ の推論規則（あるいは LJ で許容される推論規則）を元にタクティック
を用いてゴール変換を行いながら推論を進める．なお，基本はゴール変換による証明である
が，仮定を書き換えた方が良い場合もあるので，適宜ゴール変換と仮定の書換を交えて証明
をすすめる．
以下，いくつかの例を用いながら，タクティックの説明をする．タクティックの名前を忘
れた場合は，メニューの Tacticsを見て探してほしい

2.1.2 ゴールが論理積のとき
Lemma Iand:A->(B->A/\B).

を証明しようとして，intros を行うとゴールが論理積 A/\B になる．なお，論理結合子の
∧ は Coqでは，スラッシュ/とバックスラッシュ\*6で表す．

*6 日本語キーボードでは\は￥キーをタイプする．
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ゴールが論理積 X ∧Y の形のときは，splitでゴールを X と Y の 2つのゴールに分割

しそれぞれ証明する．これは，推論規則でいうと
Γ ` A Γ ` B

Γ ` A ∧B

に対応している．今の例では，splitで分割後，trivialで証明が終了する．

注意：ここでは説明のために introsしてから，splitしたが，splitの定義は introsを
した後に apply conj を適用するものなので，最初の intros は不要でいきなり split を
適用してもよい．

2.1.3 仮定に論理積があるとき
Lemma And1:A/\B -> A

を証明しようとして，introを行うと，仮定に論理積 A/\Bが入る．

仮定が論理積 X ∧Y の形のときは，destruct あるいは inversion で仮定を分割する．
仮定にタクティックを適用する場合は，どの仮定に適用するか指定する．ここでの使い方で
の destructと inversionの違いは，destructが元の論理積が仮定に残らないのに対し，
inversionは元の論理積を仮定に残したままにすることである．
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いずれにせよ，仮定にゴールと同じ論理式があるので，trivialで証明ができる．

これは推論規則として考えると，
Γ, A,B `C

Γ, A∧B `C

に対応している．

2.1.4 ゴールが論理和のとき
Lemma Or1:A-> A\/ B

を証明しようとして，introを行うと，ゴールが論理和 A\/Bになる．論理結合子の論理和
∨ は Coqではバックスラッシュとスラッシュである．

ゴールが論理和 X ∨Y のときは，LJでは背理法が使えないので，証明できる論理式が X

であるか Y であるかを left, right で指定する必要がある．ここでは，Aが仮定にあるの
で，leftを選択する．

推論規則としては，

Γ`A
Γ`A∨B
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Γ`B
Γ`A∨B

に対応している．背理法でないと証明できない場合については，2.1.9で扱う．
注意：split のときと同様に，left はそもそも intros の後に apply or introl を適用
するので，最初の introは不要で，最初から leftで証明できる．

2.1.5 仮定に論理和があるとき
Lemma EMDN:A\/˜A->(˜˜A -> A)

を証明しようとして，intro を行うと，仮定に論理和 A\/˜A が入る．論理結合子の否定 ¬
は，Coqではチルダ˜で表す．

仮定が論理和 X ∨Y の形のときは，destructあるいは inversionで仮定を分離し，X の
場合でも Y の場合でもいずれの場合でも証明できることを示す．推論規則では

Γ, A`C Γ, B `C

Γ, A∨B `C

に対応している．

この例では，A\/ ˜A を destruct あるいは inversion することでゴールが 2 つでき，A

を仮定する場合は trivial，˜A を仮定する場合は˜˜A が仮定にあり仮定が矛盾するので，
contradictionで証明できる．
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2.1.6 ゴールが否定形のとき
Lemma Cont:(A->B)->(˜B -> ˜ A)

を証明しようとして，introsを行うと，ゴールが否定形˜Aになる．

Coqでは，¬Aは A → ⊥（Coqでは ⊥は False）の省略系である．従って，introを使う
ことができる．

最初に適用した introsでは， ˜Aには適用されていなくて，明示的に introを使う*7こと
で，Aを仮定に入れることができている．仮定の˜Bは B-> Falseであるから，Falseを示
すには，Bを示せばよいことがわかる．推論規則としては，

Γ`X Γ, Y `Y

Γ, X→Y `Y

に対応している．（上式右は明らかに成り立つので，上式左のみを示せばよい．）これは apply

タクティックを使う．

再度，applyタクティックを使えば証明が終了する．

*7 このことからわかるように introsは introの単なる繰り返しではない．
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2.1.7 仮定に X と X → Y があるとき
Lemma HA2:(A->B)->((A->˜B)->˜A)

を証明しようとして，introsを行い，続けて introを行うと，仮定に A, A->B, A->˜Bが
入る．

仮定に X と X → Y があるとき，仮定を Y にすることができる．X を Y に書き換える
場合と X → Y を Y に書き換える場合でタクティックが異なる．specialize を用いて
specialize(H H1) とすると，仮定 H:A->Bが Bに変わる．

H:A->Bを Aから Bへの写像と考えて，H1:Aの H1を Aの元だと考えると，H(H1)は Bの元
になるが，この H(H1) を (H H1) と表して，それを実際に計算させるのが specialize に
なっていると考えられる．
specializeではなく，apply H in H1 とすると，仮定 H1:Aが Bに変わる．

今の場合，仮定 H1:Aを書き換えると，論理式 Aが消えて H0:A->˜Bへの適用ができなくな
る*8ため，前者の specializeを用いることにする．specializeを Hと H0に続けて適用
すると，仮定に Bと˜Bが入り矛盾するので証明が終わる．

*8 後で説明する generalizeと introを使用して Aのコピーを残しておけば applyでも証明はできる．
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注意：この例題では仮定を書き換える説明のために specialize を使った証明をしたが，
absurdを用いる方が自然である．absurdは LJで許容される推論規則

Γ ` A Γ ` ¬A

Γ ` ⊥
に対応している．absurd B. を適用すると，B と˜B の 2 つのゴールが生成され，仮定を
applyすることで証明が終わる．

2.1.8 同値式のとき
A ↔ B は (A → B)∧ (B → A)の略記であるから、それに準じてタクティックを適用す
る．例えば、ゴールにある場合は split、仮定にある場合は destructあるいは inversion

を使う．

演習問題 1. 次の論理式が証明可能であることを Coqで示せ．

1. (A → (B → C)) → ((A → B) → (A → C))

2. ¬(A∧B) → (A → ¬B)

3. ((A∧B) → C) → (A → (B → C))

4. (B → A) → ((C → A) → ((B ∨C) → A))

5. (¬A∧¬B ↔ ¬(A∨B)

6. (¬A∨¬B) → ¬(A∧B)
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2.1.9 古典論理
ここまでは排中律 A∨¬Aを必要としない論理式を証明してきた．Coqでは，特に仮定を
置かない限り，直観主義論理 LJで証明可能なものしか証明できない．排中律も証明するこ
とはできない．実際，排中律を証明しようとしても，ゴールが論理和の形であるから，left

か right しかタクティックが使えない．従って，排中律を仮定するしか，古典論理は扱え
ない．
古典論理を扱うために必要／便利な公理・定理を集めたライブラリーが Classicalである．
ライブラリーを読み込むには次のように宣言する*9．
Require Import Classical.

このライブラリーでは，次のように公理，Lemmaが扱われている．

Axiom classic : forall P:Prop, P \/ ~ P.

Lemma NNPP : forall p:Prop, ~ ~ p -> p.

Lemma Peirce : forall P:Prop, ((P -> False) -> P) -> P.

Lemma not_imply_elim : forall P Q:Prop, ~ (P -> Q) -> P.

Lemma not_imply_elim2 : forall P Q:Prop, ~ (P -> Q) -> ~ Q.

Lemma imply_to_or : forall P Q:Prop, (P -> Q) -> ~ P \/ Q.

Lemma imply_to_and : forall P Q:Prop, ~ (P -> Q) -> P /\ ~ Q.

Lemma or_to_imply : forall P Q:Prop, ~ P \/ Q -> P -> Q.

Lemma not_and_or : forall P Q:Prop, ~ (P /\ Q) -> ~ P \/ ~ Q.

Lemma or_not_and : forall P Q:Prop, ~ P \/ ~ Q -> ~ (P /\ Q).

Lemma not_or_and : forall P Q:Prop, ~ (P \/ Q) -> ~ P /\ ~ Q.

Lemma and_not_or : forall P Q:Prop, ~ P /\ ~ Q -> ~ (P \/ Q).

Lemma imply_and_or : forall P Q:Prop, (P -> Q) -> P \/ Q -> Q.

Lemma imply_and_or2 : forall P Q R:Prop, (P -> Q) -> P \/ R -> Q \/ R.

従って，このライブラリーを読み込むとこれらの Lemmaを利用して証明することができる．
例えば，(˜B-> ˜A)->(A->B)は古典論理でないと証明できない論理式であるが，これを証
明してみよう．introsを適用するとゴールが Bになるが，このままでは適用できる仮定が
ない．

そこで，Classicalの Lemma NNPPをゴールに適用する．apply NNPP. とすると Coqが
今のゴール Bに合わせて NNPPを適用する．

*9 Section 内でライブラリーを読み込むことは現在は推奨されていない．必要なライブラリーは Section 開
始前に宣言する．ここでは説明の都合上途中で宣言している．
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ゴールが˜˜Bになったので introが適用でき，2.1.6で使用した specializeまたは absurd

を用いて証明ができる．

あるいは，
Γ ` ¬A

A,Γ ` ⊥
は LJで許容される推論規則だが，これに対応するタクティックである generalizeを使う
こともできる．

A->Falseは˜Aのことなので，後は仮定の Hを applyすれば証明できる．

ライブラリーの Lemmaを使うもう一つの例として Peirceの論理式*10((A → B) → A) →
Aを証明してみよう．

*10 Classical の中にも Peirce という名前の Lemma があるが，それはこの論理式の特別の形で通常こちらを
Peirceの論理式とよぶ．
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intro をすると，仮定が (A->B)->A で結論が A になる．すぐに仮定を適用してゴールを
A->B にすると，証明できる形にはならない．古典論理でないと証明できない論理式なので
Classical の公理か Lemma の適用が必要である．証明の方法はいろいろあるが，ここで
は，imply_to_or:forall P Q : Prop, (P -> Q) -> ~ P \/ Q. を仮定 H に利用して
みる．タクティックの書き方は apply imply_to_or in H.である．

仮定が論理和に変わったので，destructで分割する．仮定˜(A->B)は，imply_to_and が
使えそうである．

演習問題 2. 次の論理式が古典論理で証明可能であることを Coqで示せ．

1. ¬(A∧B) → ¬A∨¬B
2. ((A → ¬A) → B) → ((A → B) → B)

3. (¬B → ¬A) → ((¬B → A) → B

4. (A → B)∨ (B → A) （ヒント：最初に NNPPを使う．）

最後に End PropositionalLogic. で Section を閉じる．Section から抜けると、
Section 内で変数として仮定されていたものが forall の形で Section 内の定義に自動的
に付加される．次にメニューの File->Save でファイルを保存する．拡張子は.v にする．
Section を閉じると、Section 内で Variable として仮定されていたものに対して，そ
の Section 外で，任意の論理式にあてはめて使用することができる．例えば，次のように
Section PropositionalLogicを閉じた後に，次のような Lemmaを示すことができる．
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apply (HA1 (X->Y) Z)は，Section PropositionalLogicで定義した HA1の Aとし
て X->Y，Bとして Zを当てはめて適用することを示している．ただし，これは同一ファイル
内で行なっているのでそのまま使えているが，他のファイルの場合はコンパイルしてから，
その.voファイルを読み込む必要がある．詳しくは 3.2で説明する．

2.2 述語論理
述語論理を Coqで扱うには，述語を定義する必要がある．述語は対象領域の要素が与えら
れると真偽が定まる命題になることを踏まえ，次のように宣言する．

ここで、Aは対象領域を表しているが、どのような型に対しても適用できるように Type型
にしる．また、P,Qは A上の 1変数述語、Rは A上の２変数述語、tは Aの要素としている．

2.2.1 仮定が全称論理式のとき
Lemma all imply:(forall x:A, P x)-> P t

を証明しようとして，introを行うと，仮定に全称論理式 forall x:A, P xが入る．
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仮定が全称論理式の場合、任意の項に対して成り立つことが仮定できる．推論規則としては

Γ, P [t/x]`C

Γ,∀xP `C

に対応している．この例の場合は仮定 Hを tに対して適用するため、apply (H t)とする．

2.2.2 ゴールが存在論理式のとき
Lemma imply exists:P t->(exists x:A,P x)

を証明しようとして，introを行うと，ゴールが存在論理式 exists x:A,P xになる．

ゴールが存在論理式の場合、古典論理でない限り、存在論理式をみたす項 t（witness とよ
ぶ）を明示しなければならない．この例の場合は、witnessとして tを選択すればよいので、
exists t として tを適用する．

2.2.3 ゴールが全称論理式のとき
Lemma alpha all:(forall x:A, P x)-> forall y:A,P y

を証明しようとして，introを行うと，ゴールが全称論理式 forall y:A, P yになる．
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ゴールが全称論理式の場合は、introを行う．推論規則としては

Γ`P [a/t]

Γ, `∀xP （ただし、aは下式には現れない変数）

に対応する．この推論規則では自由変数 aに変数条件があるが，Coqでは introを適用す
ると、自動的にそれまでに自由変数として使われていない新しい変数が用意される． 今の場
合 yは自由変数として使われていないので yがそのまま使われる*11．

後は、仮定 Hを applyを適用して証明が終わる．

最後のところで使用した apply H.の代わりに，specialize (H y)と仮定を書き換えても
証明できる．

ここで証明した ∀xP (x) → ∀yP (y)は，束縛変数を書き換えてもよいことを表す．このよ
うに束縛変数を書き換えることを α変換とよぶ．

2.2.4 仮定が存在論理式のとき
Lemma all not not ex:(forall x:A, ˜P x)-> ˜exists x:A,P x

を証明しようとして，introを続けて行うと，仮定に存在論理式 exists x:A, P xが入る．

*11 言語で変数記号を自由変数と束縛変数に分ける場合もあるが，Coqでは分けていないので注意する．
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仮定が存在論理式の場合は destructを行う．推論規則としては

Γ, P [a/x]`C

Γ,∃xP `C （ただし、aは下式には現れない）

に対応する．Coqでは destructを適用すると、自動的にそれまでに自由変数として使われ
ていない新しい変数が用意される．この例の場合 xは自由変数として使われていないので x

がそのまま使われる．

後は仮定 Hと xに applyを適用すると，ゴールが P xになり，trivialで証明が終わる．

ここでも最後のところで使用した apply (H x). の代わりに，specialize (H x) と仮定
を書き換えても矛盾する論理式が仮定に現れるので contradictionで証明できる．

2.2.5 タクティックのカスタマイズ
既存のタクティックを自分用に改変したり、新たに作成することができる．ここでは長い
名前のタクティックを自分用の短い名前で定義し直す方法を述べる．タクティックは Ltac

という Vernacularコマンドを用いて定義する．例えば、
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とすると、現在のゴールに対して、okとすると、trivialや contradictionを適用する．
なお、セミコロンはタクティックの逐次適用になる．従って、okを適用すると trivialを
試した後で contradictionを行う．

演習問題 3. 次の論理式が証明可能であることを Coqで示せ．

1. ¬(∃xP ) → ∀x(¬P )

2. ∃x(¬P ) → ¬(∀xP )

3. ∀x(P ∧Q) ↔ (∀xP )∧ (∀xQ)（ヒント：仮定に入った forall x, P x/\Q xを x:A

に対して destructするには，destruct (H x)のように書く必要がある．destruct

ではなく，specializeで仮定を書き換えることでもできる．
4. ∃x(P ∨Q) ↔ (∃xP )∨ (∃xQ)

5. ∃x∀yR(x, y) → ∀y∃xR(x, y)

2.2.6 古典論理でないと証明できない例
論理式 ¬(∀xP ) → ∃x(¬P )は、証明に古典論理のライブラリー Classicalが必要である．

証明を始める前に，上記の Lemma の記述で補足をする．これまで変数には型を付けてきた
が，exists xの xには型が付いていない．これは Coqが xが Pの引数になっていること
から，型を推論して決定しているからである．実際，右のペインを見てみると変数には型が
ついているのがわかる．
introを適用した時点で、ゴールに existsで適用できる項（変数）はなく、また仮定に
ある否定もはずすことができない．そこで Classical にある二重否定の除去 NNPP を用い
て、ゴールに二重否定をつけ、introで仮定に入れることにする．
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これで仮定 Hを適用することが可能になる．

ここで introを行うと、また適用できるタクティックがなくなるので再度 NNPPを適用して
introを行う．

最後に仮定 H0をゴールに適用すると、最初に適用できなかった existsが使える形になっ
ていることがわかる．

二重否定の除去 NNPP の後に，intro を行うことは，背理法で証明することに相当する．
これは，LKで許容される推論規則

¬A,Γ ` ⊥

Γ ` A

に対応する．次のようにタクティック hairihouを定義しておくと，通常の証明と同じ感覚
で背理法を利用することができる．

演習問題 4. 次の論理式が証明可能であることを Coqで示せ．

1. ¬¬∃xP → ∃x(¬¬P )

2. ¬∃x(¬P ) → ∀xP
3. ∃xA ↔ ¬∀x¬A
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4. ∃x(P (x) ↔ ∀yP (y))

演習問題 5. セクションを閉じて，ファイルを保存せよ．

最後にこれまで紹介してこなかった強力なタクティックの intuitionについて説明する．
intuitionはライブラリの Tautoで定義されていて，Coqを起動すると自動的に読み込ま
れる．intuitionはゴールや仮定からの推論が「明らか」なときに使えるタクティックで，
これまでいろいろなタクティックを説明するためにあえて使ってこなかったが，命題論理の
ところで扱った例の多く（特に LJで証明できるもの）は，intuition.だけで証明できた
り，証明が短縮できる．intuitionがどのように定義されているかを説明しないが，自分で
新たにタクティックを定義しようとする場合，よい参考になる．

3 集合の基本的性質の証明
3.1 ライブラリ Ensemblesを利用した集合の性質の証明
3.1.1 ライブラリ Ensembles

Coqを用いて数学的な主張を証明するための例としてここでは集合のかんたんな性質を証
明して行くことにする．集合を Coqでどのように扱うかであるが，（Coqには Setという型
があるが）Libraryの Ensemblesを使うことにする．Ensembles.vは Coqのインストー
ルフォルダ内にある．
Ensemblesでは次のように集合（Ensemble）を定義している．

Variable U : Type.

Definition Ensemble := U -> Prop.

U が全体集合で，その部分集合を Ensemble と定義していると考えることができる．
Ensembleは，この定義だと前節の述語論理での述語の扱いと変わらないが，これは U 上の
述語とその述語をみたす元の集合の関係

R(a) ↔ a ∈ {x ∈ U | R(x)} (*)

を考えれば，同じ扱いでよいことがわかる．次は集合の要素関係 ∈の定義である．

Definition In (A:Ensemble) (x:U) : Prop := A x.

これも上記の (*) を考えればこの定義でよいことがわかる．次は集合の包含関係の定義で
ある．

Definition Included (B C:Ensemble) : Prop :=

forall x:U, In B x -> In C x.

これは通常の包含関係の定義である．次は全体集合と空集合の定義である．
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Inductive Full set : Ensemble :=

Full intro : forall x:U, In Full set x.

Inductive Empty set : Ensemble :=.

ここで Inductive は，対象を帰納的に定義する場合の用語である．Full set の定義にあ
る Full introはこの集合のコンストラクタ（この集合の元は何であるかを示すもの）で，
Full setに関わる事実を証明する際に，この名前を用いて apply Full introのように使
うことができる．一方，Empty setには何も書かれていない．これはコンストラクタがない
（つまり何もないから空である）ことを表している．
空集合と全体集合を Inductive ではなく Definition で定義すると次のようにできる．
この二つの定義の同等性は後で証明する．

Definition Full set : Ensemble := fun x:U=>True.

Definition Empty set : Ensemble := fun x:U=>False.

fun x:A=>yは写像の対応関係でよく使われる x 7→ y を表している．従って，Definition

による定義は，Ensembleの型である U->Propが，Uから Propへの写像であると考えると
自然な定義である．Inductive で定義した場合と Definition で定義した場合で証明で使
うタクティックが変わるが，説明は具体的な証明の中で行う．
集合に関する演算の和集合 (union)∪，共通部分 (intersection)∩ は次のように Inductive

に定義する．

Inductive Union (B C:Ensemble) : Ensemble :=

| Union introl : forall x:U, In B x -> In (Union B C) x

| Union intror : forall x:U, In C x -> In (Union B C) x.

Inductive Intersection (B C:Ensemble) : Ensemble :=

Intersection intro :

forall x:U, In B x -> In C x -> In (Intersection B C) x.

集合 Bと Cの和集合の元は，Bの元であるか Cの元のいずれかであることと定義され，共
通部分は Bの元かつ Cの元であることと定義されている．ライブラリ Ensemblesで定義さ
れている他の演算の定義については，集合の基本的な性質を証明しながら説明する．

3.1.2 基本的性質の証明
ここで証明する集合の性質は，集合と写像に関する授業資料*12から抜粋したもので，付録
に掲載をしている．定理や問題番号はそれに沿っているので適宜参照してほしい．なお，こ
の先 Unicodeの記号を利用するため，メニューの Edit->Preferencesを選び，Filesの File

charset encoding が UTF-8になっているか確認し，UTF-8でない場合は UTF-8を選択す
る必要がある．（選択後 OKをクリックする．）

*12 http://herb.h.kobe-u.ac.jp/nst/
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最初に Ensemblesをインポートする．背理法を使うことがあるので，Classicalもイン
ポートする．また，論理のところで定義した 2 つのタクティックも使えるようにする．ま
た，集合の型を Ensembleと書くのは面倒なので，略記を用意する．

Coqで証明するときに見やすいように，最初に Notation で略記を定義する．2項演算を
定義するときは，結合の強さと結合の順序を定義する必要がある．ここでは複合命題を表現
するときに，仮定やゴールの表示でカッコを省略せずそのまま表示するようにするためにす
べて no associativity で指定しておく．また，この後，証明する命題の主張を簡潔にす
るため，使用する変数も定義する．

集合の元であるかないかを示すには排中律が必要になる．
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x が集合 A の元であるかどうかで場合分けするには，この in or not が必要になる*13．
Coqの章の述語論理のところで述べたように，Coqが型を推論できる部分は表現を簡潔にす
るために上記のように型を省略することにする．以下，付録にある集合や写像の性質を Coq

を用いて証明をしていく．
命題 A.1 A ⊆ B かつ B ⊆ C ならば A ⊆ C.

最初に部分集合の包含関係 Included を定義に従って分解する．これは unfold

Includedを行う．

次に intros.を行う．これで現在の状況は

である．あとは，destruct Hを行い分解された仮定を使えば証明が終了する．

Includedの分解はよく行うので，タクティックとして定義する．

定理 A.2 空集合は任意の集合の部分集合である．すなわち，任意の集合 Aに対し，∅ ⊆ A

が成り立つ．
証明は，intro. bubun. destruct H.で終わる．

*13 この資料で使用するのは．問題 A.8の証明のところである．
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ここで扱う集合は全体集合の部分集合であるのでそれも示示す．

証明で注意すべき点は，intro;bubun.を行った後，Full setの定義のコンストラクタで
ある Full intro を使うことである．apply Full intro とすると，結論が一気に証明で
きる．なお，splitは introsした後に，ただ一つのコンストラクタを適用することなので，
この Lemmaは splitとするとすぐに証明が終わる．

今後集合の同等性を示すことが多くなるが，それには外延性の定理を用いる．

Axiom Extensionality Ensembles :

forall A B:Ensemble, Same set A B -> A = B.

ここで，Same setの定義は，

Definition Same set (B C:Ensemble) : Prop :=

Included B C /\ Included C B.

であるから，通常の外延性定理 ∀A,B[A ⊆ B ∧B ⊆ A → A = B]である．ゴールに入る
/\を分解することまで含め，次のようにタクティック seteq を定義する．今後集合の同等
性を示す場合は最初にこの seteqを使用する．

定理 A.3 集合 A,B,C に対し，次の関係式が成り立つ．

1. A∪A = A

2. A∪B = B∪A
3. A∪(B∪C) = (A∪B)∪C
4. A ⊆ A∪B,B ⊆ A∪B
5. A,B ⊆ C → A∪B ⊆ C

証明で注意することは和集合のコンストラクタ Union introlと Union introrの使い
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方だけであるが，leftや rightは introsした後にそれぞれコンストラクタの 1と 2を適
用するものなので，leftと rightを使用するほうが簡単である．より一般的には，n番目
のコンストラクタを適用する constructor nを用いて，constructor 1や constructor

2でも構わない．証明を後で見直す時に，Union introlと Union introrと書いてある方
が見やすいということだけである．
seteq の後最初のゴールは簡単で 2つ目のゴールの証明で bubunを適用すると次のよう
になる．

ここで apply Union introl あるいは left を適用する*14．するとゴールが x ∈ A に変
換されて証明ができる．

A.3の 3の証明では，仮定に∪がある場合は destructで分解される（\/と同じ）ことと
Union introlと Union introrの使い分けに気をつける．

演習問題 6. 定理 A.3の 4と 5及び問題 A.4の左から右を証明せよ．

問題 A.4の右から左を示すときに，タクティックの新しい使い方が必要になる．introを
行うと次の状況になる．

ここで仮定に対して，destruct Hを適用すると，ゴールが A ⊆ A ∪ Bに変わる．これ
は，仮定 Hを利用してゴールの Bを A ∪ Bに書き換えたことになる．明示的に等式を利用し

*14 この場合は apply Union introrあるいは rightでも良い．
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て書き換えるタクティックは rewriteである．rewrite は仮定にある等式の左式を右式に
置き換えるが，今回のように右式を左式に置き換えるには rewrite <-を用いる．rewrite

H ではなく，rewrite <- Hとするとゴールが確かに変わる．

あとは定理 A.3の 4の最初の式を用いれば良い．（以下の証明では，定理 A.3の 4の最初の
式の命題の名前を bubun unionlとしている．

定理 A.5 集合 A,B,C に対し，次の関係式が成り立つ．

1. A∩A = A

2. A∩B = B∩A
3. A∩(B∩C) = (A∩B)∩C
4. A∩B ⊆ A,A∩B ⊆ B

5. C ⊆ A,B → C ⊆ A∩B
6. A ⊆ B ↔ A∩B = A

証明は，使うタクティックが Intersection intro であることを除けば，和集合と同
じようにできる．この場合も split がコンストラクタの 1 を適用するものなので，apply

Intersection introよりも splitを使用する方が簡単である．

演習問題 7. 定理 A.5を証明せよ．

Ensemblesでは，Disjointは次のように定義されている．

Inductive Disjoint (B C:Ensemble) : Prop :=Disjoint intro :

forall x:U, ˜In (Intersection B C) x) -> Disjoint B C.

すなわち，B∩ Cに元がないときに，Disjoint B Cと定義している．よって，Disjoint
ならば共通部分は空集合になるが，それを示すのが次の Lemma である．
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specialize で仮定を書き換えるのは論理のところで行ったのと同じである．ここでも
apply Disjoint intro ではなく split を使うことができる．rewrite H in H0 は等式
Hを用いて，仮定 H1を書き換えるときの書き方である．

演習問題 8. 定理 A.6と問題 A.7の左から右を証明せよ．

次に問題 A.7の右から左を証明する．

この時点で仮定とゴールを見ると，，仮定 H0 より x ∈ A ∪ B が成り立ち，さらに仮定 H

より x ∈ B ∩ Cとなり x0 ∈ Bが証明できることがわかる．しかし，これを実現するために
は，x ∈ A∪ Bが仮定にないといけない．このような証明の途中に必要な事実を入れるには
assertあるいは cutを用いる．

assert (x ∈ (A∪ B)).

を評価すると，ゴールが x ∈ A∪ Bになる．

証明が終了するとこれが仮定に入る．
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後はこれまでと同様に証明を行えばよい．cutの場合は，証明の順序が逆になる．cut (x

∈ (A∪ B)). とすると，さきに，これを用いて証明するモードになり，終わると x ∈ A∪
Bを証明するモードに入る．
いずれを用いても，後は仮定に入れた x ∈ (A∪ B)により証明ができる．

差集合 Seminusは Definitionで次のように定義されていて，和集合や共通部分のよう
なコンストラクタがないため，unfoldを多用する必要がある．
Definition Setminus (B C:Ensemble) : Ensemble :=

fun x:U => In B x /\˜In C x.

コンストラクタの代わりになる Lemma を証明しておくと便利である．差集合の記号は以
下のように定義する．

差集合についてもこれまでの同様に証明ができるがこの節の最初に説明したように
in or notを使う必要のあるものがいくつかある．その一つが問題 A.8の (A−B) ∪ (A ∩
B) = Aである．
この問題は A ⊆ (A−B) ∪ (A ∩B)を示す時に，x ∈ B の場合と x /∈ B の場合に分けて
証明する必要が出てくる．
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このときのゴールは x∈ (A \ B)∪ (A ∩ B) であるが，仮定に Bに関する情報がないた
め，和集合のどちらに入るか決定することができない．そこで
destruct (in or not B x)

とすることで x ∈ Bの場合と˜(x ∈ B)の場合に分けることができて証明が完成する．

ここで前に言及した Full set と Empty set を Inductive と Definition で定義した
ものの同等性を示しておく．具体的には次の 2つの Lemmaになる．証明は特に難しいことは
ない．これらにより，Full set Uは，fun x:U => Trueであり，Empty setは fun x:U

=> Falseであることがわかる．

演習問題 9. 付録 Aの残りの定理と問題を証明しなさい．

最後に Sectionを終了する．

End SetTheory.

集合に関してここまで証明したものを Shugo.vとして保存する．

3.2 ライブラリーの作成と読み込み
3.2.1 ライブラリーの作成
自分で定理を証明したものをライブラリーとして作成するには，ファイル（.vファイル）
を開いた状態でメニューの Compileから Compile bufferを選ぶ．これで同じディレクトリ
に.voファイル（と.globファイル）が生成される．ライブラリを読み込むときに使用するの
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はこの.voファイルである．
前節で作成した Shugo.vを Compileして，新しいライブラリを作成する．作成したライ
ブラリを読み込んだときに，新たに作成したタクティックと集合演算の記法がそのまま使え
るように，Shugo.vの End SetTheoryの後に以下のものを記述した後に Compileを行い，
ライブラリを作成する．
Ltac ok:=trivial;contradiction.

Ltac hairihou:=apply NNPP;intro.

Ltac seteq:=apply Extensionality Ensembles;unfold Same set;split.

Ltac bubun:=unfold Included;intros.

Notation "x ∈ A":=(In A x)(at level 50,no associativity).

Notation "A ⊆ B":=(Included A B)(at level 100,no associativity).

Notation "A ∪ B" :=(Union A B)(at level 80, no associativity).

Notation "A ∩ B":=(Intersection A B)(at level 80, no associativity).

Notation "A \ B":=(Setminus A B)(at level 60, no associativity).

Notation ø :=(Empty set ).

Notation Ω:=(Full set ).

3.2.2 ライブラリの読み込み
作成したライブラリを読み込むには，ライブラリーの置かれているフォルダーを LoadPath

で指定してから，Require Import を用いる．例えば，hogehoge.vo を置いたフォルダの
絶対パスを PATHとするとき，hogehogeを読み込むには

Add LoadPath "PATH".

Require Import hogehoge.

とする．

3.3 集合族
自分で作成したライブラリーの利用の演習も兼ねて，集合族のかんたんな性質を証明する．
まず最初に必要なライブラリー Shugoを読み込む．Windows 10の場合は

のように書く．ここでは C:\Users\makoto\Documents\coqにライブラリーがおかれてい
ることにしている．Mac OS Xの場合は
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のように書く．ここでは/Users/makoto/Desktop/Coq にライブラリーがおかれているこ
とにしている．

一般に集合 Λの元 λに対して，集合 Fλ が決められているとき，{Fλ

∣∣ λ ∈ Λ} を Λを添
字の集合とする集合族とよぶ．添字の集合は空ではないと仮定する．
ここでは，集合族の Coqにおける定義を次のように考えることにする．

集合族 {Fλ

∣∣ λ ∈ Λ} に対し，Fλ のいずれかの元となるようなものの全体，すなわち
∃λ ∈ Λ[a ∈ Fλ]をみたす aの全体を {Fλ

∣∣ λ ∈ Λ}の和集合とよび，⋃
{Fλ

∣∣ λ ∈ Λ}あるい
は

⋃
λ∈Λ

Fλ で表す．また，集合族 {Fλ

∣∣ λ ∈ Λ}に対し，Fλ のすべてに共通な元の全体，すな

わち ∀λ ∈ Λ[a ∈ Fλ]をみたす aの全体を {Fλ

∣∣ λ ∈ Λ} の共通部分とよび，⋂
{Fλ

∣∣ λ ∈ Λ}
あるいは

⋂
λ∈Λ

Fλ で表す．

このことを踏まえ，集合族の和集合と共通部分の Coqにおける定義を次のようにする．

集合族については次の定理 B.1, B.2が成り立ちますが，これを Coqで確かめてみる．

定理 B.1 集合族 {Fλ

∣∣ λ ∈ Λ}と集合族の構成元 Fλ0 に対し，次が成立する．

1. Fλ0
⊆

⋃
λ∈Λ

Fλ (λ0 ∈ Λ)

2.
⋂
λ∈Λ

Fλ ⊆ Fλ0
(λ0 ∈ Λ)

定理 B.2 集合族 {Fλ

∣∣ λ ∈ Λ},{Gλ

∣∣ λ ∈ Λ}に対し，次が成立する．

1.
⋂
λ∈Λ

Fλ ⊆
⋂
λ∈Λ

Gλ ↔ ∀λ ∈ Λ[Fλ ⊆ Gλ]
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2.
⋃
λ∈Λ

Fλ ⊆
⋃
λ∈Λ

Gλ ↔ ∀λ ∈ Λ[Fλ ⊆ Gλ]

この証明は，和集合と共通部分のコンストラクタ unionf introと interf intro を使
うところに注意をすれば特に難しいことはない．

次に，定理 B.3を確かめてみる．
定理 B.3 集合族 {Fλ

∣∣ λ ∈ Λ}と集合 Aに対し，次が成立する．

A ∪ (
⋂
λ∈Λ

Fλ) =
⋂
λ∈Λ

(A ∪ Fλ)

この定理を Coqで表現するためには，集合族 {A ∪ Fλ}λ∈Λ を定義する必要がある．この
定義は，Definitionで行う．各 λ ∈ Λに対して，A ∪ Fλ を対応させることに注意する．

証明中で UFam を定義に従って書き換えるとき，ゴールにある場合は unfold UFam. と
し，仮定 Hにある場合は unfold UFam in H.とする．
定理 B.3を証明する際に，問題となる箇所は次の部分である．
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ゴールは和集合なので，どちらに入るか決めないといけないが，この時点の仮定ではどち
らに入るか決めることはできない．そこで in or notを用いて，x ∈ X の場合と x /∈ X の
場合分けを行う．後は特に難しいところはない．

演習問題 10. 問題 B.4を示せ．ただし，集合族 {A ∩ Fλ}λ∈Λ は次のように定義する．証明
中で IFamを書き換えるは，UFamと同様に unfoldを使用する．

また，添字集合が空でないことを明示するために，以下の宣言をする．

最後にファイルをファイル名を Family.v にしてコンパイルせよ．コンパイルしたファイ
ルは，同値関係のところで Importする．

4 写像の性質の証明
ここで証明する写像の性質は，集合と同様 http://herb.h.kobe-u.ac.jp/nst/から抜
粋したもので，付録 Cに掲載をしているものである．

4.1 像と逆像の定義
集合族の性質の証明と同様に，ライブラリをインポートする．

写像は定義域と値域の集合を型としては区別する必要があるため，次のように UShugoと
VShugoを定義する．Set Implicit Argumentsを宣言すると，型が推論できるような引数
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を省略することができる．

f : A → B と C ⊆ A,D ⊆ B に対し，f による C の像 f(C) と f による D の逆像
f−1(D)は次のように定義される．

f(C) = {f(a) | a ∈ C}, f−1(D) = {a ∈ A | f(a) ∈ D}

よって，Coqでは次のように定義するのが自然である．

4.2 像の性質の証明
まず最初に x ∈ X ならば f(x) ∈ f(X)であることを示す．証明は直線的にできる．

定理 C.3 f : U −→ V とする．A,B ⊆ U とするとき，次の関係が成り立つ．

1. A ⊆ B → f(A) ⊆ f(B)

2. f(A ∪B) = f(A) ∪ f(B)

3. f(A ∩B) ⊆ f(A) ∩ f(B)

順に証明すると次のようになる．いずれも集合で証明したときに用いたことと像のコンス
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トラクタから証明ができる．証明中では像のコンストラクタを直接適用しているのではなく
splitで代用している．特に共通部分に関わるところでは，像のコンストラクタを使うとこ
ろと共通部分のコンストラクタを使うところをどちらも splitで代用しているので，どちら
を使用しているのか注意せよ．

4.3 逆像の性質の証明
次に逆像に関することを証明してみる．まず最初に，x ∈ f−1(Y ) ↔ f(x) ∈ Y を示す．
証明は逆像のコンストラクタを用いることで容易にできる．ここでも逆像のコンストラクタ
を指定する代わりに splitで代用している．

次に，f−1(Y ) = f−1(f(U) ∩ Y )を示す．

定理 C.6 f : U −→ V とする．C,D ⊆ U とするとき，次の関係が成り立つ．

1. C ⊆ D → f−1(C) ⊆ f−1(D)
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2. f−1(C ∪D) = f−1(C) ∪ f−1(D)

3. f−1(C ∩D) = f−1(C) ∩ f−1(D)

1.の証明では，特に難しいところはない．

2. は集合の同等性を証明するので，これまで同様にすすめると

となる．ここで，f(x) ∈ C ∪D ↔ f(x) ∈ C ∨ f(x) ∈ D を使うために仮定 H を使いたい
が，そのまま destruct Hとすると，f(x)の情報も失われてしまう．

そこで destructではなく inversion H.とする．そうすると，f(x)の情報も保存される
ので証明が進む．

destructを使う場合は，一旦 y = f(x)とおいて，変数 y にしてから destructするこ
とにする．そのために使うのが rememberタクティックである．remember (f x) as yと
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することで，仮定に Heqy: y = f xが追加され，destruct H.の後に rewriteすると，
仮定が実質 f x ∈ Cと f x ∈ Dに場合分けされる．

しかし，このようなことをしなくても，inversionで簡単にできる．
後は，同様に証明をすすめることできる．

3.も同様にできる．

演習問題 11. 問題 C.7 を示せ．なお，U, V を集合として扱う場合は，(Full set U),

(Full set V)とすることに注意せよ．
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5 関係
この章では関係を扱う．ここで証明する関係の性質は，集合と同様授業資料*15から抜粋し
たもので，付録 Dに掲載をしているものである．集合と集合族に関する概念を必要とするの
でライブラリ Shugo, Familyを読み込む．

5.1 同値関係
2項関係 Rは，次の条件 R1,R2,R3を満たすとき，それぞれ反射的 (reflexive)，対称的

(symmetric)，推移的 (transitive)であるという．

R1: ∀a ∈ A[aRa]

R2: ∀a, b ∈ A[aRb → bRa]

R3: ∀a, b, c ∈ A[aRb∧ bRc → aRc]

Coqでも次のように定義する．

反射的，対称的かつ推移的である関係を同値関係 (equivalence relation)とよぶ．

*15 http://herb.h.kobe-u.ac.jp/nst/
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5.2 同値類
Rを A上の同値関係とする．任意の a ∈ Aに対し，aと同値な関係にある Aの元全体を

[a]で表すことにする．すなわち，

[a] := {b ∈ A
∣∣ aRb}

とおく．[a] の形の集合を同値類 (equivalence class) とよび，a をその同値類の代表元とよ
ぶ．代表元の取り方は，一意的には決まらない．Coqで同値類を定義するためには，最初に
同値関係を決めておく必要がある．そのために Hypothesisを用いる．

これにより，これ以降 Rは同値関係として仮定される．Coqで仮定にある同値関係を反射
的，対称的，推移的のそれぞれの関係にわけるタクティック eqrelを次のように定義する．

ここで，destruct equiv as [ref symtran]は，Equivalent relation Rを destruct

したときに，最初の仮定 Reflexive R に ref というラベルをつけ，残りの Symmetric R

/\Transitive Rに symtranといラベルをつけることを表す．さらに destruct symtran

as [sym tran]により，対称律と推移律の式に symと tranのラベルがつけられることに
なる．
その上で，同値類を次のように定義する．

xRxであるから，x ∈ [x]となるがこれを最初に確認する

eqrelで同値関係の性質を 3つにわける．
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同値類のコンストラクタ eqclass introでゴールを変換する．

反射律 refを用いれば証明終了である．

次に xRy ならば [x] ⊆ [y]を示す．

結論と仮定の Hと H0を見ると，推移律を適用できそうであるが，推移律を適用するには仮
定 Hの変数の順序を入れ替える必要があるので，symを用いる．
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これで推移律が適用できるので証明が終わる．

tranに引数を与えているのは，どの順で適用するか指示する必要があるからである．
tranに引数が必要な理由は，Transitiveの定義が

で，apply tranを行うときの仮定とゴールの状況が Γ, R y x,R x y0`R y y0だったから
である．そこで，仮定にある H0:R x y0を introの逆の操作を行う revertを使い revert

H0とすると，tranを適用できる形になり apply tran.で証明ができる．

定理 D.1 A上の同値関係 Rの同値類に関して次が成り立つ．
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1. ∀a, a′ ∈ A(aRa′ → [a] = [a′])

2. ∀a, a′ ∈ A(¬(aRa′) → [a] ∩ [a′] = ∅)

3.
⋃
a∈A

[a] = A

1.は演習問題とする．2.を証明する．

ここで absurd (R x y)として，∼R x yと R x yのいずれも導かれることを示す．∼R x

yは明らかで，R x yは H1を revert してから，tranを applyして証明ができる．ある
いは，specializeで仮定を書き換えて矛盾を出す方針でも構わない．

3.の証明には，Family.vで定義した集合族の和集合を用いる．3.の左辺はここでの定義に
従えば，集合族 {[x] | x : U}の和集合であるから，最初にこの集合族を次のように定義する．

これを踏まえて，証明すべき命題と証明は次のようにできる．

演習問題 12. 定理 D.1の 1.を示せ．
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付録A 集合
A.1 部分集合と集合の相等
A.1.1 部分集合
命題 A.1. A ⊆ B かつ B ⊆ C ならば A ⊆ C

A.1.2 集合の相等
A ⊆ B かつ B ⊆ A ならば，∀x[x ∈ A ↔ x ∈ B] が成り立つから外延性の公理より，

A = B である．

A.2 空集合
定理 A.2. 空集合は任意の集合の部分集合である．すなわち，任意の集合 Aに対し，∅ ⊆ A

が成り立つ．

A.3 集合の演算
A.3.1 和集合
定理 A.3. 集合 A,B,C に対し，次の関係式が成り立つ．

1. A∪A = A

2. A∪B = B∪A
3. A∪(B∪C) = (A∪B)∪C
4. A ⊆ A∪B,B ⊆ A∪B
5. A,B ⊆ C → A∪B ⊆ C

問題 A.4. A ⊆ B ↔ A∪B = B を示せ．

A.3.2 共通部分
定理 A.5. 集合 A,B,C に対し，次の関係式が成り立つ．

1. A∩A = A

2. A∩B = B∩A
3. A∩(B∩C) = (A∩B)∩C
4. A∩B ⊆ A,A∩B ⊆ B

5. C ⊆ A,B → C ⊆ A∩B
6. A ⊆ B ↔ A∩B = A
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A∩B = ∅のとき，Aと B は 互いに素 (mutually disjoint)であるとよばれる．

A.3.3 和集合と共通部分の関係
定理 A.6. 集合 A,B,C に対し，次の関係式が成り立つ．

1. A∪(B∩C) = (A∪B)∩(A∪C)

2. A∩(B∪C) = (A∩B)∪(A∩C)

3. A∪(A∩B) = A , A∩(A∪B) = A

問題 A.7. A ⊆ B ⊆ C ↔ A ∪B = B ∩ C を示せ．

A.3.4 差集合
定義より A−B ⊆ A, (A−B) ∩B = ∅が常に成り立つ．

問題 A.8. (A−B) ∪ (A ∩B) = Aを示せ．

命題 A.9. A ⊆ C かつ D ⊆ B ならば A−B ⊆ C −D

問題 A.10. A ⊆ B ↔ A−B = ∅であることを示せ．

問題 A.11. A− (A−B) = A ∩B を示せ．

問題 A.12. A,B ⊆ C とする．A ∩B = ∅ ↔ A ⊆ C −B を示せ．

問題 A.13. (A− C) ⊆ (A−B) ∪ (B − C)を示せ．

定理 A.14 (ド・モルガンの法則). 集合 A,B,C に対し，次の関係式が成り立つ．

1. A− (B∪C) = (A−B)∩(A− C)

2. A− (B∩C) = (A−B)∪(A− C)

問題 A.15. 次を示せ．

1. (A∪B)− C = (A− C)∪(B − C)

2. (A∩B)− C = (A− C)∩(B − C)

3. (A∩C)−B = (A−B)∩C
4. (A∪C)−B ⊆ (A−B)∪C

付録B 集合族
定理 B.1. 集合族 {Fλ

∣∣ λ ∈ Λ}と集合族の構成元 Fλ0 に対し，次が成立する．
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1. Fλ0 ⊆
⋃
λ∈Λ

Fλ (λ0 ∈ Λ)

2.
⋂
λ∈Λ

Fλ ⊆ Fλ0 (λ0 ∈ Λ)

定理 B.2. 集合族 {Fλ

∣∣ λ ∈ Λ},{Gλ

∣∣ λ ∈ Λ}に対し，次が成立する．

1.
⋂
λ∈Λ

Fλ ⊆
⋂
λ∈Λ

Gλ ↔ ∀λ ∈ Λ[Fλ ⊆ Gλ]

2.
⋃
λ∈Λ

Fλ ⊆
⋃
λ∈Λ

Gλ ↔ ∀λ ∈ Λ[Fλ ⊆ Gλ]

定理 B.3. 集合族 {Fλ

∣∣ λ ∈ Λ}と集合 Aに対し，次が成立する．

A ∪ (
⋂
λ∈Λ

Fλ) =
⋂
λ∈Λ

(A ∪ Fλ)

問題 B.4. 集合族 {Fλ

∣∣ λ ∈ Λ}と集合 Aに対し，次が成り立つことを示せ．

1. A ∪ (
⋃
λ∈Λ

Fλ) =
⋃
λ∈Λ

(A ∪ Fλ)

2. A ∩ (
⋂
λ∈Λ

Fλ) =
⋂
λ∈Λ

(A ∩ Fλ)

3. A ∩ (
⋃
λ∈Λ

Fλ) =
⋃
λ∈Λ

(A ∩ Fλ)

付録C 写像
C.1 像
命題 C.1. f : U −→ V,X ⊆ U とする．x ∈ X ならば f(x) ∈ f(X)である．

命題 C.2. f : U −→ V,X ⊆ U とする．y ∈ f(X) であるための必要十分条件は ∃x ∈
X[y = f(x)]である．

定理 C.3. f : U −→ V とする．A,B ⊆ U とするとき，次の関係が成り立つ．

1. A ⊆ B → f(A) ⊆ f(B)

2. f(A ∪B) = f(A) ∪ f(B)

3. f(A ∩B) ⊆ f(A) ∩ f(B)

C.2 逆像
命題 C.4. f : U −→ V, Y ⊆ V とする．∀x ∈ U [x ∈ f−1(Y ) ↔ f(x) ∈ Y ]である．

命題 C.5. f : U −→ V, Y ⊆ V とする．f−1(Y ) = f−1(Y ∩ f(U))である．
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定理 C.6. f : U −→ V とする．C,D ⊆ U とするとき，次の関係が成り立つ．

1. C ⊆ D → f−1(C) ⊆ f−1(D)

2. f−1(C ∪D) = f−1(C) ∪ f−1(D)

3. f−1(C ∩D) = f−1(C) ∩ f−1(D)

問題 C.7. f : U −→ V とする．C,D ⊆ V とするとき，次の関係が成り立つことを示せ．

1. f−1(V − C) = U − f−1(C)

2. f(f−1(C)) = C ∩ f(U)

3. C ∩ f(U) ⊆ D ∩ f(U) ↔ f−1(C) ⊆ f−1(D)

付録D 関係
D.1 同値類
定理 D.1. A上の同値関係 Rの同値類に関して次が成り立つ．

1. ∀a, a′ ∈ A(aRa′ → [a] = [a′])

2. ∀a, a′ ∈ A(¬(aRa′) → [a] ∩ [a′] = ∅)

3.
⋃
a∈A

[a] = A

問題 D.2. 定理 C.1の 1.の逆を示しなさい．
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